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About this manual

This manual will help you to become
familiar with Springboard Publisher.
Once you have completed this manual,
you may set it aside. When you want to
learn in detail about everything that
Springboard Publisher can do, turn to the
Reference manual. And when you need a
reminder about the keystrokes required
to accomplish a certain task, check the
Desktop Reference card.

This manual is organized into the
following chapters:

Welcome! presents the basic concepts
behind Springboard Publisher. There is a

list of the equipment that you need, and
a chart that will help you decide how to
approach the program and the manuals.

Starting Springboard Publisher explains
how to start the program.

Creating your first document takes you
step by step through the creation of a
sample document. It is organized in such
a way that you can spend just a few
minutes to learn the basics, or invest a
little more time and learn some of the
program’s more advanced features.

Welcome! = 9



What will you need?

Basic equipment

To use Springboard Publisher you need:

B an Apple Ile, IIc, or IIGS computer with
at least 128K memory

B one 3.5” disk drive
B a printer
B the original Master program disk

B a storage disk for the documents you
create. You can use a floppy disk or
hard disk.

This additional hardware is
recommended:

B A RAM disk, second disk drive, or
hard disk

H A mouse

Other considerations

- Backup the program disk!

To protect against accidents, you should
make a copy of the program disk and use
your copy to run the program. To make a
backup, use the "disk copy” option of the
Apple system utilities or your favorite
copy program. After you make your
backup, store the original disk in a safe
location. Do not give a copy of the
program to anyone else; that would be a
violation of copyright laws.

Free artwork

The Master program disk includes
samples of the professionally designed
art created especially for Springboard
Publisher. By purchasing this program,
you are entitled to receive one free
Springboard WORKS OF ART package*
and other special offers. See the Bonus
Pack for details.

*There is a nominal shipping and handling service charge for the free artwork.
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Where should you
begin?
T

Are new to Apple computers Read the owner’s manual for your
computer.

Are using a mouse for the first time Read the owner’s manual for your
mouse.

Want to learn the basics of Finish reading this chapter.

Springboard Publisher before you start

using it

Want to start using Springboard Make a backup copy of the original

Publisher right away disk. Insert your copy of the Master

program disk and turn on your
computer. After a setup procedure in
which you’ll identify the type of
equipment you have, you will be able
to start the program.

Have a RAM card that needs to be Read the Starting Springboard
initialized as a RAM disk whenever Publisher chapter in this manual.
you start an application (for example,

RamWorks)

Want to learn how to use Springboard Finish reading this chapter, then
Publisher’s page layout, word complete the Creating your first
processing, or graphics features document chapter in this manual.

Everyone should complete Lesson 2:
Laying out the page.

If you are familiar with mouse-based
word processing and graphics
applications, you can skip those
sections.

Know the basics of Springboard Read the Reference manual.
Publisher but want to learn the
advanced features of the program

Welcome! »11



What is Springboard

Publisher?

Springboard Publisher combines three
applications—page layout, word
processing, and graphics creation—in one
powerful package. And yet it is so easy
to use that you will be producing
attractive documents in no time. With
Springboard Publisher you can create
newsletters, advertising flyers, school
and business reports, fanciful or
functional artwork, books, calendars,
indeed any combination of text and
graphics.
For each application, Springboard
Publisher displays a different mode, or
viewpoint of your page:
B Page mode is the best mode to use
when you are creating your page

layout. In page mode, you see a
reduced version of an entire page. (The

12« Welcome!

page is reduced because your
computer screen is not large enough to
show a page at actual size.)

B Text mode is the mode to use for word
processing. Text mode shows a page at
actual size; you see the entire width of
the page and about one-third its
length.

B Graphics mode is the one to use for
creating illustrations. Graphics mode
shows a slightly enlarged view of your
page; this enables the program to show
more accurately how your illustrations
will look when printed.

Switching from one mode to another is
quick and easy; you never have to leave
the page. At any time you can interrupt
your word processing, for example, and
change your page design.
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Whenever you want, you can switch from one
mode to another without leaving the page.
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How does it work?

The key to Springboard Publisher’s
power and simplicity is that you can put
whatever you want, wherever you want,
whenever you want. Let’s see what that
means for each of Springboard
Publisher’s three applications:

Page layout

Page layout is the process of arranging
the various elements of a page.
Springboard Publisher imposes virtually
no rules about how you must lay out a
page; you can arrange the various
elements however you want. There are
four elements that comprise a page
layout:

B Page margins: the white space around
the outside of your page.

B Text frames: rectangular areas you
create for special text such as a
quotation or a headline.

B Graphics frames: rectangular areas you
create for your illustrations.

B Regular text area: the rest of the
page—whatever is not defined as a
margin, text frame, or graphics
frame—is the regular text area. In a
typical document the regular text area
is where you will put most of your
text. The regular text area can be
divided into as many as nine columns.

14+ Welcome!

With Springboard Publisher, it’s easy to
change your page layout. At any time,
you can create a new text frame or
graphics frame. You can change the
number of columns even after you have
entered text. You can move an
illustration, shrink it, or enlarge it. No
matter what you do or when you do it,
the program’s Intuitive Text™ feature
automatically arranges your text to
conform with your page layout.

For most page layout operations you will
want to use page mode, because it allows
you to see an entire page at one time.
However, all of Springboard Publisher’s
page layout commands also work in text
mode and graphics mode, which means
that you can change your layout even
while you are entering text or creating
illustrations.



Page mode shows the
entire page at one time.

IE) Text frame: an area you
define for special text. You
can create text frames of
any size and put them
anywhere on the page. You
can divide text frames into
as many as 9 columns.

Graphics frame: an area
you define for your
illustrations. You can create
graphics frames of any size
and put them anywhere on
the page.

B} Regular text area: any
part of the page that is not
defined as a text frame,
graphics frame, or page
margin. You can divide the
area into as many as 9
columns.

I3 Rulers help you position
frames exactly where you
want them.
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Word processing

Word processing is composed of two
major functions:

B Entering text. You can enter and edit
text using Springboard Publisher’s
own word processing program, or you
can import documents from popular
word processing applications such as
AppleWorks or Bank Street Writer.

When you are entering text in the
regular text area it wraps
automatically from line to line, from
column to column, and from page to
page. If you change your page layout,

the text adjusts itself to the new layout.

It’s easy to make changes to the text
you have entered. Springboard
Publisher provides cut and paste
functions that allow you to select text
and move it anywhere within or
between documents.

16= Welcome!

Text frames are completely
independent from the regular text
area. All of Springboard Publisher’s
text entry and editing features work
inside a text frame without affecting
the text in the regular text area.

Formatting text. Springboard
Publisher gives you tremendous
flexibility in the appearance, or
formatting, of your text. You can
choose from several styles and sizes of
type. You can make text bold,
underline it, italicize it, or even print
white characters on a black
background. You can align paragraphs
on the left or right margin or center
them. Finally, you can adjust the
amount of space between lines of text
and between individual characters.



In text mode, you can
see the entire width of the
page and about one-third

its length.

B Regular text area.
Notice how the text wraps

around a frame.

Columns. Each text
area can have up to 9
columns. The program
makes all columns the
same width but allows you
to adjust the width of each
column individually.

) Text frame. The text in
the frame is completely
separate from the text in
the regular text area.

[3 Scroll bar. Lets you
move the page up and
down.
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Graphics

The graphics capabilities of Springboard
Publisher are powerful and fun to use.
There are two ways to add artwork to a
document:

B Create your own artwork. Springboard
Publisher offers many of the artistic
tools you might expect to find in an
artist’s studio. For example, there is a
pencil with which you can draw thin
black lines. There is a paintbrush, a
spray can, and a paint bucket. There
are 24 patterns to embellish your
artwork. And there are tools for
creating rectangles, ovals, and other
predefined shapes.

In addition to the basic graphic tools,
Springboard Publisher offers many
advanced features for customizing
your artwork. You can move an image
within or between graphics frames.
You can make an image larger or
smaller. You can turn an image on its
side or upside down. You can even
temporarily magnify part of an image
so that you can make detailed changes
to it.

18+ Welcome!

B Import artwork from outside sources.

When you need top quality artwork in
a hurry, Springboard Publisher lets
you bring in artwork from outside
sources. Most exciting is Springboard’s
WORKS OF ART series. Each WORKS
OF ART volume contains more than
500 pieces of beautiful and functional
artwork created at double high
resolution especially for Springboard
Publisher. See the Bonus Pack for
details about receiving one free
volume of Springboard’s WORKS OF
ART series*.

You can also import artwork from
Springboard’s Clip Art Collections as
well as MousePaint and many other
sources.

*There is a nominal shipping and handling
charge.
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Summary

This chapter has introduced you to the
features of Springboard Publisher.

Here are the main points:

® Springboard Publisher is three
applications—page layout, word
processing, and graphics creation—all
in one program.

® The program displays a different
mode—page, text, or graphics—for
each of the applications. At any time,
you can switch from one mode to
another without leaving your page.
You can do word processing in text
mode, graphics creation in graphics
mode, and page layout in any mode.

® Page mode is the best mode in which
to create your basic page layout, which
consists of:

® Page margins—the white space
around the outside of the page

20s Welcome!

# Text frames—areas you define for
special text

® Graphics frames—areas you
define for illustrations

® Regular text area—the rest of the
page, for most of your text

® Word processing consists of entering

and formatting text. Springboard
Publisher has its own powerful word
processor, the ability to import
documents from other word
processing applications, and a wide
assortment of formatting options.

You can create your own illustrations
using Springboard Publisher’s
extensive graphic tools and
commands. In addition, you can
import artwork from Springboard’s
WORKS OF ART and Clip Art
Collections and many other

Apple II-compatible graphics
applications.
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Before you begin

A word about /RAM

Springboard Publisher uses 128K
memory. If you have been running
another ProDOS program immediately
before starting Springboard Publisher,
Springboard Publisher disconnects the
special /RAM that ProDOS installs in
memory. (This /RAM is part of your
computer’s Random Access Memory and
is not related to any RAM disk card you
may have installed.) Before you switch
applications, be sure to save anything
that the other application may have
stored on /RAM.

Apple keyboards

Apple keyboards are not all alike. In this
manual:

When you see... Use this key...

& (8] or
& [Option] @ or

Hardware setup

Before you install Springboard Publisher,
make sure your hardware is set for
optimal performance. Springboard
Publisher’s performance is greatly
enhanced when you use a RAM disk. A
RAM disk is extra memory that operates
as a disk drive. The instructions that
follow are organized according to the
type of computer you have: Ile or Ilc, or
IIGS.

NOTE: If you are an Apple Ile or Ilc
user whose RAM disk is either
RamWorks or MultiRam, be sure to read
the instructions in the Ile and Ilc section
that describe how you can automatically
initialize your RAM disk each time you
start Springboard Publisher.

Apple IIGS users

Before you use Springboard Publisher for
the first time, you need to change some
items in the control panel. Basic
instructions are provided here; for
additional information about the control
panel, see your Apple IIGS owner’s
manual.

1. Insert your copy of the Springboard
Publisher program disk in drive 1.

2. If your computer is turned off, turn it
on.

If your computer is turned on, press
Control- & -Reset. Release Reset first,
pause a second, then release the other
keys.

Starting Springboard Publisher «23



a1

- The program begins the setup
procedure. Do not answer the question

about the mouse. Instead, go to the
Apple IIGS desk accessories by
pressing Control- 5 -Esc. Use the
up/down arrow keys to select the
control panel, then press Return.

. Set the system speed. Use the up or

down arrow to select System Speed,
then use the left or right arrow to
select Fast, then press Return.

- Set the startup slot. Use the up or

down arrow to select Slots, then use
the up or down arrow to select Slot 5,
then press Return.

. Select the RAM disk option.
B If you have 256K extended memory,

set RAM disk maximum and
minimum size to 0 (zero) K.

B If you have 512K extended memory,

set RAM disk maximum and
minimum size to 512K.

B If you have 1Mg extended memory,
set RAM disk size to the largest size

possible.

If you will be working on large

documents, you may want to put all

available extended memory (1Mg)
on your RAM disk.

If you will be working on small
documents, leave some room for
Diversi-Cache to operate.
(Diversi-Cache is a program built
into Springboard Publisher that
speeds up the process of saving
documents.) Set the size to 768K.

For Springboard Publisher Copy,
Save, Import Text, and Import
Graphics commands, always put
your data disk in drive 1.

24 « Starting Springboard Publisher

This RAM disk setup takes best
advantage of the Diversi-Cache
program. Diversi-Cache stays active
even when you quit Springboard
Publisher. If you wish to disable
Diversi-Cache after you quit
Springboard Publisher, go to the
desk accessories, choose
Diversi-Cache, and change Enabled
to No.

7.1f you intend to use the AppleTalk
network, AppleTalk must be installed
in the control panel.

(@)

a. Go to the control panel.
b.

Choose Slots.

Select Slot 7. You want Slot 7 to
say Built-in AppleTalk. (If it does,
goontod.)

If Slot 7 says Your Card, press the
right arrow to toggle it so it will
say Built-in AppleTalk.

Note: At this point, there is a
chance that you will get a message
that says “Warning: Printer/
Modem/ AppleTalk cannot be
active at the same time!!!” If this
happens, before completing the
Slot 7 setup, you need to look at
Slot 1 and Slot 2—one of them
needs to say Your Card. If neither
Slot 1 nor Slot 2 says Your Card, go
to Slot 1, select it, and toggle it
(using the right arrow) until you
see Your Card. Now go back to Slot
7 and set it up to say Built-in
AppleTalk.

(In this installation, Your Card does
not mean you are installing an
actual card.)



Now select the slot for AppleTalk.

If AppleTalk is connected to your
printer port, select Slot 1. If it says
Your Card, you are finished with
the AppleTalk installation. If it
doesn’t say Your Card, press the
right arrow to toggle.

If AppleTalk is connected to your
modem port, select Slot 2. If it says
Your Card, you are finished with
the AppleTalk installation. If it
doesn’t say Your Card, press the
right arrow to toggle.

When you are finished, Slot 7 will
say Built-in AppleTalk, and either
Slot 1 or Slot 2 will say Your Card.

Quit the control panel. Use the up or
down arrow to select Quit, then press
Return. From the Desk Accessories
menu, select Quit again, then press
Return.

). Turn off your computer.

10. If you are using the AppleTalk

network, insert the IIGS system disk
and turn on your computer. Then,
using the Finder or the Launcher,
start Springboard Publisher using the
file called SP.SYSTEM.

If you are not using the AppleTalk
network, insert your copy of the
Springboard Publisher program disk
and turn on your computer.

11. Complete the Springboard Publisher

setup procedure.

12. If you must reset the control panel for

another application, repeat this
procedure before you start
Springboard Publisher again.

Starting Springboard Publisher «25



Apple Ile and IIc RAM
disk users

Depending on the brand of RAM disk
and the amount of memory available,
Springboard Publisher will use the RAM
disk for the scratch disk*, the program, or
both.

In general, it works like this:

Available @~ | =
'RAM disk memory | RAM disk use

Less than 512k scratch disk

512K-768K scratch disk or
program

768k and up scratch disk and
program

*The scratch disk must be available at all
times when you are running Springboard
Publisher. The scratch disk is what
Springboard Publisher uses to store a
document while you are working on it.
This frees up memory space for the
program.

If you have:

® RamFactor or Apple Ile Memory
Expansion Card, we recommend that
you install it in slot 7, drive 1.

8 Laser 128EX RAM, we recommend
that you install it in slot 5, drive 1.

8 Z-Ram,
Z-Ram Ultra 1, 2, or 3,
or RamWorks I, 11, or 111

You have two options for setting up
your RAM disk. You can either
initialize it each time, immediately
before you start Springboard

26 Starting Springboard Publisher

Publisher, or you can do a one-time
setup procedure that will
automatically initialize it for you
thereafter. The instructions for each
option follow.

To initialize automatically (this is a
one-time operation):

Using your favorite copy utility, copy
ProDrive to the SETUPS directory on
your Springboard Publisher disk.

ProDrive is used to initialize the RAM
disk. After copying ProDrive,
whenever you start Springboard
Publisher a program called
SETUP.SYSTEM** will run all files in
the SETUPS directory, then it will
start Springboard Publisher.

(Remember, SETUPS is important to
your RAM disk initialization; don’t
delete it from your Springboard
Publisher disk some day when you're
cleaning up directories!)

To initialize manually:

If you want to initialize manually, you
must format your RAM card every
time, immediately before you start
Springboard Publisher. You need to
use ProDrive to configure the RAM
disk for slot 3, drive 2.

Note: If you do not do this procedure
before you start Springboard
Publisher, the program will let you
know with a message that begins
"The RAM card is not initialized as a
RAM disk.” Press Esc to quit, then
proceed to set up your RAM disk as
described below.

**SETUP.SYSTEM is a public domain
program written by Sean Nolan and
described in Call — A.P.P.L.E., November,
1987.



Caution: Pressing Control-Reset or
typing PR# disconnects the RAM
disk.

Insert the ProDrive utility disk and
turn on your computer.

2. Select the ProDrive Options Menu.
3. Select “Install ProDrive.”

1. Insert your copy of the
Springboard Publisher Master
program disk.

5. At the BASIC prompt, type
-/SP/SP.SYSTEM and press
Return.

. If this is the first time you are
using Springboard Publisher, the
program begins the setup
procedure.

MultiRam Ile

You have two options for setting up
your RAM disk. You can either
initialize it each time, immediately
before you start Springboard
Publisher, or you can do a one-time
setup procedure that will
automatically initialize it for you
thereafter. The instructions for each
option follow.

To initialize automatically (this is a
one-time operation):

Using your favorite copy utility, copy
MultiDrive.Pro to the SETUPS
directory on your Springboard
Publisher disk.

MultiDrive.Pro is used to initialize the
RAM disk. After copying
MultiDrive.Pro, whenever you start
Springboard Publisher a program
called SETUP.SYSTEM will run all
files in the SETUPS directory, then it
will start Springboard Publisher.

(Remember, SETUPS is important to
your RAM disk initialization; don’t
delete it from your Springboard
Publisher disk some day when you're
cleaning up directories!)

To initialize manually:

If you will manually initialize, you must
format your RAM card every time,
immediately before you start
Springboard Publisher. You need to use
MultiDrive.Pro to configure the RAM
disk for slot 3, drive 1.

Note: If you do not do this procedure
before you start Springboard Publisher,
the program will let you know with a
message that begins “The RAM card is
not initialized as a RAM disk.” Press Esc
to quit, then proceed to set up your RAM
disk as described below.

Caution: Pressing Control-Reset or
typing PR# disconnects the RAM disk.

1. Insert the MultiRam format utility
disk and turn on your computer.

2. Select "Install MULTIDRIVE.PRO
(ProDOS RAM disk).”

3. Select "Install MultiDrive.PRO.”

4. Respond N to the question “"Run the
FILER now (Y/N)?”

5. Select "Exit to BASIC.”

6. Insert your copy of the Springboard
Publisher Master program disk.

7. At the BASIC prompt, type
-/SP/SP.SYSTEM and press Return.

8. If this is the first time you are using
Springboard Publisher, the program
begins the setup procedure.

Starting Springboard Publisher 27
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The setup procedure

The very first time you start Springboard
Publisher, the program leads you
through a setup procedure. In addition to
setting up Springboard Publisher to work
on your computer, the setup procedure
teaches you a little about how
Springboard Publisher works. When you
have completed the setup procedure, the
program will install itself with the
settings you chose.

The next time you start Springboard
Publisher, the program will start right
away without going through the setup
procedure. If you ever need to repeat the
setup procedure (to make a change), you
can do so when you start the program.
Press Esc when you see the "bouncing”
Springboard logo or the Springboard
Publisher title screen.

If you haven’t completed the hardware
setup yet, do so before completing these
steps. See the previous section of this
chapter, called Hardware setup, for
instructions.

1. Insert your copy of the Master
program disk in drive 1.

® If your computer has a built-in
disk drive, then that is drive 1.

® If your computer has a built-in
5-1/4” disk drive, open the 5-1/4”
drive door and leave the drive
empty.

If your computer is turned off, turn it

on.

B If your computer is already on,
press Control- G -Reset. Release
the Reset key first.

3. The program asks if you have a
mouse and then displays some
general information about how to use
your mouse or keyboard. (If you later
forget how to use the mouse or
keyboard, you can see the setup
procedure’s Help information by
pressing H, or you can refer to
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“Entering data in a dialog box” later
in this chapter.)

Note: If you do not see the mouse
question, then the setup procedure
has already been completed. Take the
time now to read about entering data
in a dialog box, then proceed to the
Creating your first document chapter
in this manual.

When you have read the mouse or
keyboard information and pressed
Return, the program displays the first
of many dialog boxes that you will
use in Springboard Publisher. A
dialog box is a message from the
program that requests information
from you. For example, the Summary
dialog box that you see now shows
how Springboard Publisher is
currently set up and asks if you want
to change any of the setup items.

5. Review the preset items. Descriptions

of each item appear on the following
pages.

6. Select any one item that you wish to

change. (After you change an item,
the program returns to this screen to
allow you to select another item to
change.) To select an item:

® Mouse users: Point to the "button”
next to the item you want to
change and “click” (press and
release the mouse button). Then
click OK.

®  Keyboard users: Press the up or
down arrow key on your keyboard
to select the item you want to
change. A dot appears in the
“button” of the selected item.
”Click” (press % or press Return)
when the desired item is selected.

7. When all items are correct, “click” the

No changes button, then click OK or
press Return.



Entering data in a dialog box

Here are the keys you need to use in a
dialog box:

Move pointer Within a category, press the up and down Move the mouse on
arrow keys on your keyboard to move from | your desk.
one option to the next.

In dialog boxes that contain more than one
category of information, press Tab to move
from one category to the next.

Select option Press the § or Option key when the pointer | Move pointer to
(“Click™) lands on your desired selection. option then click
mouse button.
Confirm all Press Return when all your selections are Click the OK
selections correct. button, or

double-click, or
press Return.

Get help Press H if you need Help. The program will | Same as keyboard.
display information to assist you in making
the proper selection. You can choose Help

throughout the setup procedure, but not in

the regular program.
Go back to Press Esc if you make a mistake and want | Click the Cancel
previous step to go back to the previous step. button or press Esc.
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Device options

This dialog box allows you to specify the
disk from which you wish to run
Springboard Publisher.

Set up on hard disk

You should choose this option if you
have a hard disk.

Set up on current disk

This is the recommended option if you
do not have a hard disk.

E File Edit Mode Layout Paragraph Font FontSize FontStyle Graphics

Device Options

(O Set up on hard disk,
(® Set up on current disk.

Type H for Help.
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RAM disk

As part of the setup procedure, the
program searches your computer for a
RAM disk. If you have more than one
RAM disk, or if you do not want
Springboard Publisher to use the RAM
disk, you may change the current setup.

B Click Use It if you want Springboard

Publisher to use the RAM disk shown.

B Click Next if you have another RAM
disk that you want Springboard
Publisher to use.

B Click Don’t Use if you do not want
Springboard Publisher to use a RAM
disk. This choice will cause the
program to run considerably slower.
Springboard Publisher performance is
greatly enhanced if you use a RAM
disk.

Found RAM disk in Slot 5, Drive 2
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Printer

The brand of printer you select
determines the maximum amount of text,
measured in pixels, that can appear on a
given line.

1. Click the button next to your type of
printer.

B AppleTalk LW refers to a setup in
which your computer is connected
to a LaserWriter or compatible
printer via AppleTalk.

B Serial LW refers to a setup in
which one computer is connected
to a LaserWriter or other laser
printer via a normal serial
communication channel.

B AppleTalk IW refers to a setup in
which your computer is connected
to an ImageWriter or compatible
printer via AppleTalk.

B Dot Matrix refers to a setup in
which one computer is connected
to any strictly dot-matrix printer.

2. Depending on your computer

equipment and which option you
choose, you may need to select the
name of your printer and interface
card. If you do not see your brand,
use the scroll bar to reveal more
brands:

B Mouse users: Point to one of the
scroll bar arrows and hold down
the mouse button. Release when
you see your brand, then click
your brand.

B Keyboard users: Press Tab to move
the pointer to the desired list.

Hold down the down arrow key
on your keyboard to scroll the list.

Use the up or down arrow key to
highlight your brand.

3. If you selected an AppleTalk setup,

select the correct printer, if necessary,
then type your name in the User
Name box. You must type a name or it
won't let you continue.

Springboard Publisher Printer Setup

Printer

Apple DMP
fipple Imagelriter

Current Setup: Apple Imagellriter //
Apple //gs Printer Port

(=) Default

) Yes
O No

Apple ImageWriter /{
Apple Imagelriter L1

Interface Card
fipple High-Speed Serial ik T
fipple //c Port | [L-]
Apple #{qs Printer Port
Apple Parallel Printer
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If necessary, change the number of the
slot in which you have your interface
card.

B Mouse users: Point to the slot
number. Hold down the mouse
button and "drag” (move) the
pointer across the number. The
number is highlighted.

Type the correct number.

B Keyboard users: Press Tab until the
slot number is highlighted. Type
the correct number.

5. If necessary, change the Line Feed

setting. Unless you have customized
your printer in some way, choose the
Default setting.

B  Mouse users: Click the button next
to the desired setting.

B Keyboard users: Press Tab to move
to the Line Feed box, then press
the down arrow key on your
keyboard to highlight the desired
setting.

6. When all settings are correct, click OK

or press Return. The program returns
to the setup summary.
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Mouse, character set, sound,
double-click speed

1.

Click the Mouse box to turn the
mouse on and off. When Springboard
Publisher is set up for a mouse, an X
appears in the box.

B A mouse makes Springboard
Publisher easier to use, and it
provides a few extra features that
are not available to keyboard
users.

Click the Sound box to turn Sound on
and off. If you do not wish to hear a
beep when the program displays a
warning message, turn Sound off.

If you want to change the double-click
speed, type a different number.

B Double-clicking is a common
procedure, used to make a
selection of some type. It is usually
a quick operation—two rapid
presses of the mouse button or #.
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B Note to IIGS users: The faster
operating speed of your computer
requires you to double-click more
rapidly than Ilc or Ile users. You
will probably not wish to select the
fastest speed.

. Click the button next to the language

in which you intend to write.

B The Quick Reference chapter in the
Reference manual contains a table
for the international character set
and instructions for switching
temporarily from one set to
another.

. When all settings are correct, click OK

or press Return.



Scratch disk

A scratch disk is what Springboard During the setup procedure, Springboard
Publisher uses to store a document while Publisher identifies the best location for
you are working on it. The scratch disk the scratch disk: the program disk, your
must be available at all times when you RAM disk, or your hard disk. It is not a
are working on a document. Preparing a good idea to change the scratch disk
scratch disk is taken care of during the setup.

setup procedure that happens the very
first time you start Springboard
Publisher.

If you have inserted a blank
Setup Scrateh Disk disk, type a name for the
disk, then select OK or press
Return. The name must
begin with a letter and can
consist only of letters,
numbers, and periods.

Name Scratch Disk ...

If you have inserted a
formatted disk, the program
will display its volume
‘ name. Make sure you want

to use that disk as the scratch
disk, then select OK.

Select Cancel if you decide
to use a diferent disk.

Starting Springboard Publisher «35



Everyday startup procedure

As you know by now, the very first time
you start Springboard Publisher, the
program runs the setup procedure. The
next time you start Springboard
Publisher, and all times after that, the
program starts without going through
the setup procedure. For future reference,
here’s how it works:

If you have a RAM disk that must be
formatted each time you start
Springboard Publisher, do so. See
”Apple Ile and Ilc RAM disk users”
earlier in this chapter.

N

Insert your copy of the original
Master program disk in drive 1. If
your computer has a built-in disk
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drive, then that is drive 1. If your
computer has a built-in 5 1/4” drive,
open the drive door and leave the
drive empty.

Turn on your computer and monitor.
If your computer is already on, press
Control- & -Reset. Release Reset first.

If you set up Springboard Publisher to
run from a RAM disk, the program
copies the necessary files to that
device.

Choose the New command from the
File menu if you want to start a new
document, or choose the Open
command if you want to work on an
existing document.



Creating Your
First Document
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When you have completed
this chapter, you will have

created and printed a

page that looks similar

to this one.

Armerica

Independence Day:

Celebrates lts Freedom

Every year the
United States celebrates
the Fourth of July. There
are fireworks and picnics
in the park.

Amid the

declare the causes which
impel them to the
separation.”

The Declaration
continues with these

ulienable righ, but let

us consider for a moment
the simple phrase "the
consent of the governed."
It asserts that ordinary
citizens have the right to
choose their leaders

celebrations,
however, it is
important for us to
remember what we

and to remove from

m office those who
cease to represent
their will.

are celebrating: the
signing of one of the most
influential documents in
history, the Declaration of
Independence.

The Declaration
begins: "When in the
course of human events,
it becomes necessary for
one people to dissolve
the political bonds which
have connected them with
another, and to assume
among the Powers of the
earth, the separate and
equal station to which the
Laws of Nature and of
Nature's God entitles
them, a decent respect to
the opinions of mankind
requires that they should

immortal words:

"We hold these
truths to be self-evident,
that all men are created
equal, and that they are
endowed by their Creator
with certain unalienable
Rights, that among these
are Life, Liberty and the
pursuit of Happiness.
That to secure these
rights, Governments are
instituted among Men,
deriving their just powers
from the consent of the
governed..."

Readers of the
Declaration of
Independence are
generally most impressed
with those magnificent

This was a radical
concept in 1776; indeed, it
was viewed by many as
unworkable. Eighty-seven
years later, Abraham
Lincoln would
acknowledge that this
concept was still under
trial. In his famed
Gettysburg Address,
Lincoln stated that
America had yet to
demonstrate "...that
government of the
people, by the people,
and for the people, shall
not perish from the
Earth."
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Terms you need
to know

Certain terms appear throughout this now. Then, as you are working through
manual. If you did the setup procedure this chapter, feel free to turn back to this
yourself, you will be familiar with at page or to look up the terms on the
least some of them. Look over the terms Desktop Reference card.
Press a key Apply pressure for just a moment,
then let up on the key.
Hold down a key Apply continued pressure to the key.
Click Press the mouse button, or, if you do
not have a mouse, press $ [Option].
Double-click Press the mouse button or @ [Option]

twice in rapid succession

Move the pointer Move your mouse on your desk, or
press an arrow key on your keyboard.

Drag First, move the pointer to the desired
location. Next, hold down the mouse
button and move the mouse on your
desk, or hold down ¢ [Option] and
press an arrow key.
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Overview of this

chapter

This chapter will help you learn how to
use Springboard Publisher as quickly as
possible. Here’s how it works:

B The chapter is divided into seven short
lessons:

B Lesson 1: Starting a new document
B Lesson 2: Laying out the page

B Lesson 3: Word processing

B Lesson 4: Graphics

B Lesson 5: Printing a document

B Lesson 6: Closing a document

B Lesson 7: Opening a document

B Each lesson is composed of several
tasks. Most of the tasks are used in the
creation of even the simplest
document. Upon completion of the
tasks, which will take only a few
minutes, you will be ready to create
your own documents.

B At the end of some lessons is a section
titled “Details, Details,” which contains
information about some of the more
advanced features of Springboard
Publisher. When you get to these
sections, read the major headings. If a
certain topic interests you, you can
learn about it; otherwise, you can
move on. You are liable to discover
that many of these advanced features
are really very easy to learn and do,
and that you will want to use them

regularly.
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For this exercise, you will create a
simple, one-page document. The
length and complexity of your own
documents are restricted only by the
storage capacity of your data disks.

The sequence of steps—first laying out
the page, then entering text, and then
creating graphics—is only one way to
create a document. When you create
your own documents, you can do
whatever you want whenever you
want.

By no means does this chapter attempt
to cover everything you can do with
Springboard Publisher. For that you
can turn to the Reference manual.

You should try to complete this
chapter in one sitting. If you need to
stop part way through, however, first
do Lesson 6: Closing a document.
When you are ready to continue, start
with Chapter 7: Opening a document,
then pick up where you left off.



Lesson 1: Starting a
new document

Note: Your computer screen should show
Springboard Publisher’s desktop. If not,
start the program following the
instructions in the Starting Springboard
Publisher chapter.

When you start Springboard Publisher,
the program displays a “desktop.” The

o

desktop is the area on which you do your
work. Right now, the desktop is blank,
but soon it will display your new
document. The various parts of the
desktop are defined in the illustration
below.

File Edit Mode Layout Paragraph Font FontSize FoniStyle Graphics

The desktop is your

work area.

The menu bar sits at
the top of the desktop all
the time.

You can “pull down” each
menu to reveal its
commands. All of the
program’s commands are
contained in the menus.

Menu

n The pointer follows
the movement of your
mouse or arrow keys on

your keyboard.
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The menu bar

The menu bar is a device that
Springboard Publisher uses to organize

and display the program’s commands.
The menu bar sits along the top of the New N
desktop; it consists of ten menus. By Open... G0
“pulling down” the various menus, you Close G w
can quickly choose any of the program’s Save 3 S
commands. A brief summary of each Save As...
menu appears below. Rename...
Revert
E Print 3P
: : Delete...
About Springboard Publisher... Format Disk...
System Setup... ,
Printer Setup... Quit ¢ Q
Scratch Disk Setup...
The File menu has the commands you
Import Text... need to manage your documents. In
Import Graphics... addition to commands for opening,

The Springboard menu contains a variety
of commands for performing
system-related functions. The Setup
commands allow you to change some of
the options you selected during the setup
procedure. The Import commands let
you bring in text and graphics files from
outside sources.
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saving, and printing documents, there
are Rename, Delete, and Format Disk
commands so that you can perform these
functions without leaving Springboard
Publisher.



Undo
Cut

Copy
Paste
Clear

ERERER G
<OXN

Select Page
Select Regular Text

Show Paragraphs
Show Ruler
Define Ruler...

GR

Hide Tools
Hide Palette

The Edit menu help
to text and move or

s you make changes
copy a selection of

text or a graphic image.

In addition, you can use the Ruler

commands to assist

in laying out your

page. You can display a ruler that

measures in inches,
pixels.

centimeters, or

Page GH
Text

Graphics

Intuitive Text wye
Reformat GSF

The Mode menu provides one method
for switching between page, text, and
graphics modes. The Intuitive Text and
Reformat commands speed up program
operation when you edit text or change

page layout.
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Document...
Columns...
Page Numbering...

Define Text Frame Wi
Define Graphics Frame ~ C3 K
Set Frame Border... 3L
Bring To Front
Send To Back

The Layout menu provides commands to
help you design your page. You have
complete control over where to put your
page margins; how many columns you
want for text and how wide you want
each column to be; and where to place
text frames and graphics frames.

Also, you can use the Page Numbering
command to instruct the program to
print page numbers automatically.
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Paragraph

Normal

Left
Centered
Right
Justified

Single Space
Double Space
Custom Space...

Formats... GBM
Tabs... GT

The Paragraph menu helps you format
your text. You can keep the same format
for your entire document, or you can
change it from one paragraph to the next.

In addition, the Paragraph menu offers
tab stops and tab “leaders”—characters
such as dots or dashes that appear
automatically in the spaces between tabs.



The Font, Font Size, and Font Style
m menus reveal the commands that control
the appearance of your text.

Gothic _ If you are entering text in a graphics
Sans Serif frame, you can instruct the program to
Serif format the text horizontally, vertically, or
even diagonally.
Formats... €3 D
9 point <asm
10 point Scale Gy
o Flip Horizontal
P Flip Vertical
idpoint Rotate
24 palnt Trace Edges GE
36 point Invert
48 point
72 point Special Effects...
Mirrors...
m_ Brushes...
Edit Pattern...
Plain Text :
Bold & B Edit Brush...
ﬁagc line all g l!l The Graphics menu contains a variety of
VRCOTING:A1 powerful commands for creating and
MM words modifying your artwork. You can zoom
Underline characters in on a small portion of an illustration for
Qutline detail work; flip your artwork left to
Slhadowj right or top to bottom; make an image
Superscript larger or smaller; or modify the
Subscript program’s paintbrush and fill patterns to
[ Inverse | fit your specific needs.
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Choosing a command

Now that you are familiar with the menu
bar, you are ready to choose your first
command. The procedure is different for
mouse users and keyboard users; follow
the instructions that apply to you.

Mouse users

Move the pointer to the File menu,
then hold down the mouse button.

The file menu will open up, revealing
its list of commands.

. Still holding down the mouse button,
move the pointer to the New
command; the command will be
highlighted.

Release the mouse button.
The program will display a blank
page.

Keyboard users

You pull down a menu by holding down
the & key and typing the number
corresponding to a particular menu:

Press 3 -2 to pull down the File menu.

Press your down arrow key until the
New command is highlighted.

Press Return.

The program will display a blank
page.

The watch

The pointer turns into a watch when the
program is busy carrying out a
command. When the program is ready to
accept your input again, the watch
disappears.

Dimmed commands

You may have noticed that some of the
commands on the File menu were shown
in light, “dimmed” type. The program
dims those commands that are inactive at
any given time. For example, the Save
command was dimmed because there
was no document to save.
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Lesson 2:

Laying out the page

At the completion of this lesson you will
have created the basic design for the
document, including paper size, page
margins, columns, a text frame, and a
graphics frame.

When you are creating a document, it
pays to give some serious thought to
your page layout, because the
appearance of a page affects the reader’s
reaction to it. An attractive page invites a
reader to examine the information you
have to present. A disorganized or
cluttered page makes a reader less likely
to read it. The main idea of page layout
is to design a page in such a way that the
information on the page, and not the
page’s appearance, makes a positive first
impression on the reader.

When you start a new document, the
program displays a blank page in page
mode. This is a good place to start, for
two reasons:

B Page mode is the best mode in which
to lay out your page, because you can
see the entire page at one time.

B [t's a good idea to design your page
layout before you enter text or
graphics. Your layout determines not
only where your text and graphics will
go, but also how much you can fit on
the page. Later, when you are entering
text or creating illustrations, it's easy to
fine-tune the layout to fit your exact
needs.

Preset page layout
options

Springboard Publisher has certain
“preset” page layout options—settings

that the program uses unless you specify
something else. The preset options are:

B Page size: 8-1/2” by 11”. This is the
standard page size, officially called US
letter size. You may also create
documents with 8-1/2” x 14” paper,
known as US legal size. All the pages
in a document must be the same size.

B Margins: 1” all around the page. The
margins define the boundaries of the
regular text area; no regular text can
appear outside the margins. All pages
of a document must have the same
margins.

B Columns: One. Text flows across the
page from the left margin to the right
margin,

B Text frames: None. Until you create a
text frame, all the text you enter will
appear in the regular text area.

B Graphics frames: None. The program
awaits your instructions on the size
and location of graphics frames.

For this exercise, we will accept the
preset page size and margin settings. But
we will do three other page layout tasks:
define columns, create a text frame, and
create a graphics frame.
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This is what you see when
you choose the New
command from the File
menu. It is a blank page
awaiting your layout
instructions.

N Close box closes the
document. It works the
same as the Close
command on the File
menu.

El You assign a name to a
new document the first
time you save the
document. Until then, it is
untitled.

Page number shows
which page of a document
you are working on.

B) Scroll bar lets you go
quickly from one part of
the document to another. It
works the same as the
scroll bar in a dialog box.

Preset page margins are
17 all around the page.

When you start a new
document, the entire page
within the margins is a
regular text area; there are
no preset text frames or
graphics frames.

IS Rulers help you place
text frames and graphics
frames exactly where you
want them. The measure-
ments correspond to the
printed page, not to the
computer screen.

IED Ruler guides indicate
the pointer’s position on
the page.

I} The rulers’ preset unit
of measure is inches. By
clicking in this box, you can
change it to centimeters or
pixels.
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Defining columns

Columns divide a page lengthwise. You
usually create columns to improve the
appearance or readability of text. It is
sometimes easier to read two or three
narrow columns of text than to read one

The page now displays two vertical
shaded lines. These represent the
“gutters,” or space between each
column.

; 3. The preset gutter width is .25"; we
wide column that stretches across a page. won't change it now.
As you enter or erase text with ;
: . Gutters are an important part of the
?rprmgblo il I:ubh?her, thi:i@f(t fllli)w: 5 layout. They provide blank space
A e s e et Y between the columns, which makes
to page, to fill the space available. Even if .
. the text easier to read.
you change the number or width of . ‘
columns after entering your text, the text The gutter width setting applies to all
adjusts automatically. gutters on the page. This is the
accepted practice; pages almost never
When youl stafta new dociment the have gutters of different widths.
page consists of one column, in which the
text you enter would stretch from the left 4. Click the OK button.

margin of the page to the right margin.
For this exercise, let’s create three
columns.

1.

The program closes the dialog box
and displays your page. Because you
have not yet entered any text, the
page looks the same as it did before
you defined your columns.

Choose the Columns command from
the Layout menu.

We have a blank page that is set up to
align text in three columns. (You won’t
actually see the columns until you start

The program displays the Columns
dialog box. The outer rectangle in the
left of the dialog box represents the

page. The inner rectangle represents

entering text.) Now we need a special

the margins.

3 to create three columns.

In the Number of Columns box, type

area at the top of the page for the
document’s headline. For that we will
need to create a text frame.

P

Gutter Width:

Enter #, Press Retu

Number of Columns: | 3 |

= Fie Edt_Mode [ENGParagraph Font FontSize FontStyle Graphics Page
— -
m”mm Margins
Columns _ MHHHHI
Gutt
- / lw,%‘ utters

Each page can have up to
" 9 columns.

el _Gutter width must be the
same for all gutters.

0.25 in »
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Cre ating a text frame (mouse users) or ® [Option]
(keyboard users).

Text frames are one of the more
remarkable features of Springboard
Publisher. They allow you to put special
text anywhere on a page. Some uses for

text frames include: UndOing your

B Headlines that run across two or more mistakes
columns of text

The rectangle is replaced by a lined
box that represents the text frame.

Springboard Publisher has a powerful

B Captions for illustrations feature that lets you undo your most

B “Pull quotes:” boxes containing recent action. For example, if your text
information that repeats or frame did not turn out the way you
summarizes something in the regular wanted it, you could instantly erase it
text area. and start over. Let’s try it:

What you do in a text frame has no effect B Choose the Undo command from the

on the regular text area. For example, Edit menu.

entering text into a text frame does not

- Your most recent action is canceled.
change the layout of the text in the !

I Al housh Now, if you did not draw the frame
regu har s arﬁa. S(i’ RvEL 1 ougf you properly, you can try again. But what if
might set up the regular text area for two you decided that the “undone” frame

e was OK after all? Simple. Redo it!
number of columns for a text frame.

Here's how t te a text ] B Choose the Redo command from the
ere’s how to create a text frame: Edit menu.
1. Choose the Define Text Frame

The frame returns to its previous
command from the Layout menu. m > prevt

condition.
When the pointer rests on the page, it

Whenever you choose the Undo
becomes a cross.

command, it changes into the Redo

2. Move the pointer to the top left command. And when you choose Redo,
margin of the page. The ruler guides it changes back to Undo. This not only
should indicate that the pointer is 1” protects you against accidents, it also
from the top of the page and 1” from allows you to undo and redo repeatedly
the left edge of the page. so that you can look at two versions of

3. “Drag” the pointer so that the top your dofcument and decide which one
ruler guide is at 7-1/2” and the side you preter.
ruler guide is at 2-1/2”. As you drag, The Undo command works on more than
the program draws a rectangle that just text frames. In fact, almost anything
represents your text frame. that you do in Springboard Publisher

you can Undo. Undo affects your most
recent action, so be sure to use it right
away if you want to use it at all.

4. When the rectangle is in the proper
position, release the mouse button
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Position the pointer where .
you want one corner of
the frame to be...

..then drag the pointer to
the opposite corner.

On this sample page, you
can see that text in the
regular text area wraps
around text frames.

Uses for text frames
include:

Headline
Caption

Pull quote
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Moving a frame

Whenever you want, you can move a
frame. And you can move it wherever
you want—to another location on the
page, to another page, or even to another
document. If you have entered text into
the regular text area, that text will adjust
itself automatically to your new page
layout. The ability to move frames makes
it easy for you to change your page
layout at any time, without having to
worry about what will happen to the text
you have already entered.

1. Click anywhere inside the frame.

The text frame is surrounded by a

shaded area that has eight hollow

squares in it. Together, the shaded 3
area and the hollow squares comprise

the “selection box;” it indicates that

the frame is selected. When a frame is
selected, it is ready for action: you can

move it, resize it, or get rid of it. 4.
When a frame is not selected, all you

can do is look at it.

The small hollow squares, called
“handles,” are used to resize a frame;
the shaded area is used to move the
frame.

Note: If, instead of clicking, you
double-click inside the frame by
mistake, you will go into text mode.
Easy, isn’t it? But it’s not what we
want to do just yet. To get back to
page mode, choose the Page
command from the Mode menu.

Move the pointer to the shaded area
of the selection box (not on one of the
handles). The pointer will take the
shape of a four-headed arrow.

. Drag the pointer down to the middle

of the page. You'll see an outline of
the frame. When you release the
mouse button, the frame itself moves.

Practice moving the frame again; put
it back where it was. (Position both
ruler guides at 1”.)

= File Edit Mode Layout Paragraph Font FontSize FontStyle Graphics

|_ When the pointer is in the
shaded area, it becomes a

=T Unfitled

1
e

54 s Lesson 2

T I
e mownan |1
1

i
e four-headed arrow. Drag

the frame to its new
location.




Resizing a frame

Changing the size of a frame is just as 3. Try dragging with some of the other

easy as moving it: handles.

1. Move the pointer to one of the “Corner” handles allow you to change
handles of the selection box. The the length and width of a frame at the
pointer will take the shape of a same time; “middle” handles allow
two-headed arrow. you to change only one dimension.

2. Drag the handle. 4. When you are done, drag the

As you drag, the frame shrinks or
grows in the direction in which you
drag it.

You can put a frame anywhere up to
1/2” from the edge of the page. That's
as close to the edge as most printers
can manage.

appropriate handle(s) to restore the
original dimensions of the frame. (The
top left corner of the frame should be
at 17 x 1”; the bottom right corner at
7-1/2" x2-1/2".)

When the pointer is on
=| a handle, it becomes a
two-headed arrow.
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EDrag a middle handle
to change the height
or the width of a frame.

Drag a corner handle
to change both the height
and width of a frame.
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Keyboard shortcuts

You probably noticed that several of the
Edit menu commands have an Open
Apple (G ) followed by a letter of the
alphabet. This represents a keyboard
shortcut—a way for you to choose a
command without having to pull down
the menu.

To use the keyboard shortcut to choose
the Undo command:

B Press (3-Z.

B Press (5 -Z again to choose the Redo

command and restore the proper
position for the text frame.

Creating a graphics
frame

To complete this simple page layout, let’s
block out an area for an illustration.

Whether or not you need to create a
graphics frame depends on what you
want to include in the document:

B If you do not want any illustrations in
your document, then you do not need
to create any graphics frames.

B If you want to import pre-drawn
illustrations from an outside source
such as WORKS OF ART or
MousePaint, you may create a frame

first, or you may have the program
create a frame for you.

B If you want to create your own
illustrations, you must create a
graphics frame for each illustration.

_Text frame

HHU\lwmm

| il

|

i

"

’ Graphics frame
Columns are invisible until
you start entering text.

I

n—1
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In this exercise, you will be creating your
own illustration, so you need to create a
graphics frame. The process is almost
identical to that for creating a text frame:

1. Choose the Define Graphics Frame
command from the Layout menu.

2. Move the pointer so that the top ruler
guide is at 2-3/4”, and the side ruler
guide is at 4”.

3. Drag the pointer so that the top ruler
guide is at 5-3/4”, and the side ruler
guide is at 5”.

4. As you drag, the program draws a
rectangle that represents your
graphics frame. When the rectangle is
in the proper position, release the
mouse button (mouse users) or
& [Option] (keyboard users).

If the frame doesn’t turn out just right,
you can move or resize it using the same
procedure as for a text frame, or you can
choose the Undo command and start
over.

Saving your work

To protect yourself against minor
disasters such as a computer breakdown
or power failure, it is a very good idea to
save your work every 10 or 15 minutes.
That way, no matter what happens, you
will never lose more than a few minutes’
work. Even though you have not yet
finished the document, now is a good
time to save it.

You must have a formatted disk on
which to save your document; you
should never use a program disk or the
scratch disk to save your documents. If
you do not have a formatted disk, don’t
worry; you can use Springboard

Publisher’s Format Disk command
without having to abandon your
document. See the “Formatting a Disk”
instructions in the Details, Details section
that follows.

Here’s how to save a document:

1. Choose the Save As command from
the File menu.

The program displays a dialog box as
shown below.

¥ /DATA

= (e )

o

Save Current Document Rs:

PRACTICE

2. Type a name for the document.

Any name that is easy for you to
remember is good. In this chapter, we
will refer to the document as
PRACTICE. Document names can be
up to 13 characters long. They must
begin with a letter of the alphabet,
and the other characters must be
letters, numbers, or periods. Spaces
are not allowed.

3. Click the Save box or press Return.

The program transfers your document
from the scratch disk to the document
disk. Now you have a permanent
copy of the document.
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Details, Details

This section contains information about
advanced features of Springboard
Publisher. Look at the headings and
decide if you want to spend time now
learning about any of these features.

Note: Feel free to experiment with these
or any other features of the program.
When you are done, you will need to
cancel any changes you have made so
that you can continue with the other
lessons. It’s easy to cancel changes; refer
to the Canceling your changes
instructions in the Details, Details section.

Changing page size and margins

® You can change the preset page size
and margins with the Document
command on the Layout menu.

B The smallest margins Springboard
Publisher allows are one-half inch all
around the page. This amount may be
greater with some brands of printers.

8 If you set margins that are wider than
the minimum allowed, you can put
text frames and graphics frames in the
margins.

8 The rulers’ preset unit of measure is
inches. You can change it to
centimeters or pixels with the Define
Rulers command on the Edit menu, or
by clicking in the unit of measure box
between the two rulers.

Creating variable-width columns

When you define columns, the program
automatically divides the space between
the margins into columns of equal width.
Normally, this is how you will want your
columns to be. For special purposes,
however, you may want to make some
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columns wider than others. It’s easy to
do:

1. Choose the Columns command from
the Layout menu.

2. In the Columns dialog box, move the
pointer to one of the shaded areas that
represents a gutter.

3. Point to the gutter, then holding
down the mouse button, drag the
gutter to its desired location.

Creating columns in a text frame

You may also define columns for a text
frame; you must choose the Columns
command when the text frame is
selected. Columns in a text frame do not
affect the layout of the regular text area.

Saving your layout as a separate
document

For documents that you plan to use
repeatedly, such as a monthly newsletter,
you should save the document after you
have completed its page layout and before
you enter any text or graphics. This
makes it easy for you to use your page
layout over and over again.

Backing up your document disk

To protect yourself against the loss or

destruction of your document disk, it is a

very good idea to make a second copy of

the disk. There are two ways to go about

it:

® When you save a document in
Springboard Publisher, do the Save
procedure twice—once for the regular
document disk and once for the
backup disk.



Or,

8 At the end of your session in
Springboard Publisher, return to
ProDOS and use the utility that copies
files from one disk to another. (This
option is much faster.)

When you save a document with at least
one graphics frame, the program creates
and saves a companion file to store all
the graphics information for the
document. The name of the companion
file is ILENAME.G, where FILENAME
is the name you assigned to the
document. If you use the ProDOS
method of copying, you must copy both
the main document and its companion
graphics file. See “Document names” in
the Reference manual for more
information.

Putting borders around frames

Springboard Publisher has 24 border
patterns that you can use to enclose text

frames and graphics frames. Borders
help to set apart a frame from the regular
text area, and they provide an artistic
touch to a page. Borders are displayed in
text mode and graphics mode, but not in
page mode.

The program draws the border
automatically when you create a frame.
The preset border is a thin, solid line.

Here’s how to change a frame’s border:

1. Make sure the frame is selected (that
the selection box encloses it). If the
frame is not selected, click inside it to
select it.

Choose the Set Frame Border
command from the Layout menu.

N

The current border pattern appears in
the larger box at the left; the current
width is checked.

Click the pattern and width you want,
then click OK. If you do not want a
border, click the dotted-line width.

=

Border width options \

Removes border from
selected frame or creates
new frame without a

border
R
Current width

Border patterns \

Border Width —

Set Frame Border

Current pattern \
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Formatting a disk

You can format a floppy disk within
Springboard Publisher; it's not necessary
to return to ProDOS to do it.

Make sure that the disk you intend to
format does not contain anything that
you want to keep; formatting removes
any and all data that is on the disk.

1. Choose the Format Disk command
from the File menu.

2. Insert the disk that you want to
format.

3. Type the slot and drive numbers that
identify the disk drive containing the
disk.

4. Type a name for the disk.

The disk name can be up to 15
characters long. It must start with a
letter of the alphabet. The other

Nmat Disk )
Drive # ... l LEME)
E/Name Disk as.

/NEWSLETTER—————+[ &
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characters can be letters, numbers, or
periods (no spaces or special
characters).

5. Click the OK box or press Return.

Canceling your changes

Springboard Publisher allows you to
cancel all changes you have made to a
document since the last time you saved
it. It's easy:

8 Choose the Revert command from the
File menu.

Use Revert now if you have changed the
PRACTICE document while using the
features described in the Details, Details
section. The program will display an
“alert box” to make sure you want to
choose the command. Click the Yes
button.

Slot number of data
disk drive

] Drive number of data
disk drive

Type a disk name here,
E Click here when the
slot number, drive
number, and disk name

are correct.

E Cancels the operation



Summary

Your basic page layout is complete and
stored safely on disk. Here is what you
have done so far:

B Started a new document, by using the
New command from the File menu.

B Accepted Springboard Publisher’s
preset options for page size (8-1/2” x
11”) and margins (1” all around the
page).

B Created a three-column format for the
regular text area, by using the
Columns command from the Layout
menu.

B Created a text frame across the top of
the page, by using the Define Text
Frame command from the Layout
menu.

B Accepted the preset option for a thin,
solid-line border around the frame.

B Created a graphics frame that stretches
across the columns in the regular text
area, by using the Define Graphics
Frame command from the Layout
menu. Again, accepted the preset thin
border.

B Saved the document by choosing the
Save As command from the File menu.
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Lesson 3:

Word processing

Note: Your screen should display page
mode of the PRACTICE document you
created in the Page Layout lesson. If it
does not, start Springboard Publisher
(page 36) and open the PRACTICE
document (page 92).

Getting into text

mode

The PRACTICE document is laid out to
accept text in two different places: in the
text frame at the top of the page and in
the three-column regular text area. So far,
you have done all your work in page
mode (although you can do page layout
in any of the three modes). In order to do
word processing, you must get out of
page mode and into text mode. Let’s do
that now:

B Double-click anywhere in the text
frame at the top of the page.

The program displays text mode, with
the text frame selected. You can tell
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that the frame is selected because it has
the selection box around it.

Had you double-clicked in the regular
text area, the program would have
displayed that part of the page. When
you want to switch from page mode to
text mode, the most efficient way is to
double-click the part of the page on
which you want to work. Another way
is to choose the Text command from
the Mode menu.

In text mode, you can see the whole
width of the page and about one-third
its length. This allows you to see text
on the screen at about the same size
that it will be when you print it.



Close box: closes the
document. Same as the
Close command on the File
menu.

) Page number: shows
which page of a document
you are working on.

[& scroll bar: lets you go
quickly from one part of
the document to another.

) Text frame

I3 1nsertion point: this
blinking vertical line
indicates where the next
character you type will

appear.

Pointer: in text mode,
the pointer becomes an

I-beam when it is in the
regular text area or in a text
frame.

End-of-text marker:
shows the end of your
document.
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Entering text

Entering text with Springboard
Publisher’s word processor involves little
more than selecting a place to start and
typing away. Here’s how it works:

The pointer

In text mode, the pointer looks like an
I-beam when it is in an area where you
can enter text. You can use the pointer to
select already-entered text that you want
to change in some way, and also to select
the insertion point.

The insertion point

At the top of the text frame you see a
blinking vertical line. This is called the
insertion point; it shows where the next
character you type will appear. You have
already seen an insertion point in the text
box of the Save As dialog box.

When a text frame or the regular text
area is empty, the program automatically
selects the insertion point at the top of
the frame or area.
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When there is already text in the area or
frame, you select the insertion point by
moving the pointer to the desired
location within the text and clicking.

Entering text in a text frame

All you have to do to enter text into a
text frame is select the insertion point
and start typing. Because this frame is
empty, the program has already selected
the top left of the frame as the insertion
point.

Now, enter the text below into the text
frame. Later in this lesson you will learn
how to format the text to make it more
eye-catching and attractive.

B Type Independence Day: America
Celebrates Its Freedom

If you make a mistake, press the Delete
key to erase it. Pressing Delete backs
up the insertion point and erases the
character that it backs over.



Entering text in the
regular text area

The procedure for entering text in the
regular text area is the same as for
entering text in a text frame. The only
difference between a text frame and the
regular text area is that there is no limit
to the size of the regular text area. In a
text frame, you can enter only as much
text as can fit in the frame (although you
can make the frame bigger whenever you
want). In the regular text area, if you run
out of room on a page, the program
creates a new page on which you can
continue entering your text.

Here’s how to enter text in the regular
text area:

1. Move the pointer anywhere in the
regular text area and click.

This de-selects the text frame and
selects the regular text area. Because
the area has no text in it, the program
selects an insertion point at the top of
the left column.

. Choose the Show Paragraphs

command from the Edit menu.

This step is not required for entering
text, but it will help you to
understand when to use the Return
key. When the Show Paragraphs
command is turned on, the program
displays the Paragraph character | J|
whenever you press the Return key.

. Type the first two paragraphs as

shown in the box on the opposite
page. As you are entering text, keep
in mind the following:

Do not press Return at the end of
every line. Springboard Publisher has
a feature called “word wrap.” When a
word is too long to fit at the end of a
line, the program automatically
“wraps”’ the word to the beginning of
the next line. Word wrap helps you to
type more quickly, because you do
not have to worry about when to end
a line.
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the paragraph...
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between paragraphs.
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Word wrap operates not only at the
end of a line, but also around text
frames and graphics frames.

Press Return only when you want to
end a paragraph. You need to press
the Return key only when you want
to end a paragraph, and when you
want to add extra space between lines
of text. Within a paragraph, you
should always let Springboard
Publisher’s word wrap feature decide
when to end a line.

. Enter the remainder of the text. Watch
what happens:

B When the text reaches the bottom of

the screen, the program scrolls the
page one line at a time.

When you fill the first column, the
program scrolls the page to the top of
the second column and places the
insertion point there. You will hear a
beep to remind you to stop typing
until the program is able to reposition
the insertion point.

(If you get tired of typing, it is not
necessary to type all the text. Do type
enough, however, to see how the
program scrolls text from one column

to the next.)

There are fireworks and speeches and picnics in the park.

Amid all the celebrations, however, it is important for us to remember what we are celebrating:
the signing of one of the most influential documents in history, the Declaration of Independence.

The Declaration begins: "When in the course of human events, it becomes necessary for one
people to dissolve the political bonds which have connected them with another, and to assume
among the Powers of the earth, the separate and equal station to which the Laws of Nature and
of Nature’s God entitles them, a decent respect to the opinions of mankind requires that they
should declare the causes which impel them to the separation.”

The Declaration continues with these immortal words:

"We hold these truths to be self-evident, that all men are created equal, and that they are
endowed by their Creator with certain unalienable Rights, that among these are Life, Liberty and
the pursuit of Happiness. That to secure these rights, Governments are instituted among Men,
deriving their just powers from the consent of the governed.”

Readers of the Declaration of Independence are generally most impressed with those magpnificent
unalienable rights, but let us consider for a moment the simple phrase “the consent of the
governed.” It asserts that ordinary citizens have the right to choose their leaders and to remove
from office those who cease to represent their will.

This was a radical concept in 1776; indeed, it was viewed by many as unworkable. Eighty-seven
years later, Abraham Lincoln would acknowledge that this concept was still under trial. In his
famed Gettysburg Address, Lincoln stated that America had yet to demonstrate "that government
of the people, by the people, and for the people, shall not perish from the Earth.”
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Moving around
in the document

In text mode, you can see the entire
width of a page, but only about one-third
its length. In this document, you have
entered more text on the page than you
can see in the window. Naturally, there
will be times when you need to go to a
part of a document that you cannot see
on the screen. In those situations you use
the scroll bar.

The scroll bar, which sits on the right
side of the screen, symbolizes the length
of your document. With a one-page
document, the top of the scroll bar
represents the top of the page; the
middle of the scroll bar represents the
middle of the page; and the bottom
represents the bottom of the page. With a
five-page document, the top would
represent page 1, the middle would be
page 3, and the bottom would be page 5.

While you are scrolling, text and graphics
scroll off the screen. Meanwhile, nothing
new scrolls onto the screen except the
borders of frames. When you stop
scrolling, the program redraws the entire
screen.

B Experiment with the various scroll bar
techniques as explained in the
illustration below. To get to the scroll
bar:

Mouse users: Move the pointer to the
desired part of the scroll bar.

Keyboard users: Press Control-S to
move the pointer to the scroll bar, then
use the arrow keys to move to the
desired part.
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Editing text

It's easy to make changes to the text you
have entered. You can add more text;
you can delete text; you can move text
from one location to another; and you
can repeat text in several locations. No
matter what changes you make,
Springboard Publisher’s Intuitive Text
adjusts to fit the space available. In this
lesson, you will:

B Use the Intuitive Text and Reformat
commands

B Insert a new sentence
B Delete a word

B Move a sentence

Using the Intuitive Text
command

When you want to enter or edit text in an
area that already has text in it, you can
save time by turning off the Intuitive
Text command on the Mode menu

( & -G).

When Intuitive Text is on, a check mark
appears next to the command’s name on
the Mode menu. As you type, text wraps
from line to line according to your page
layout. In addition, the program must
also rewrap all the existing text that is
beyond the insertion point.

When you turn Intuitive Text off, text
wrapping of the existing text is
suspended temporarily. Regular text and
the contents of frames that are beyond
the insertion point disappear; all you see
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are the borders of frames. This allows
you to type more quickly. Later, when
you have finished editing, you can turn
on Intuitive Text or use the Reformat
command to make the existing text wrap
again.

Inserting a new sentence

1. Turn off the Intuitive Text command.
(On the Mode menu there will be no
check mark next to the command
when it is off.)

2. Use the scroll bar, if necessary, to
display the top of the page.

3. Move the I-beam pointer to the
beginning of the first paragraph of the
first column.

4. Click to select a new insertion point.

Mouse users: Be careful not to drag
the mouse when you click. Dragging
the pointer across text is one method
used to select text. If you do this by
accident, you will notice that the text
is highlighted. To correct the
situation, simply move the pointer
back to the beginning of the
paragraph and click again.

5. Type this new sentence: Every year
the United States celebrates the
Fourth of July. (And press the space
bar to insert a space between
sentences.)

6. Turn on the Intuitive Text command
( & -G). After a few seconds, the rest
of the text will reappear.
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automatically.

Every year e United  declare the causes which  unalienable rihs, but et
States cekbratesthe ~ impel them to the Us consider for a moment

Fourth of Ay, There are  separation.’y the Simple phrase “the
freworks and speeches o consent of the governed”
and pienics inthe parky  The Declarafion continues It asserts that ordinary
J with these immortal citzens have the right to
Amid al the thoose thef leaders
Celebrations, and to remove from
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Deleting a word

1. Move the pointer to the left of the “a”
in “all” in the second paragraph of
the first column.

2. Drag the pointer to the space after the
word. The word and the space will be
highlighted.

text before you can change it. When
text is selected, you can move it, copy
it, delete it, or change its appearance.

If you make a mistake, try again.
When you drag the pointer a second
time, you cancel the first selection.

Dragging the pointer across text is 3. Press Delete. The word is deleted.

one way to select text. You must select

Every year the Unfed  declare the cauises which  unalienable rights, but let
States colbratesthe ~ mpelthem to the Us consider for a moment
Fourth of Juy. There are  separafion.’y the simple phrase "the

freworks and speeches o consent of the governed”

and pierics n the parky  The Declration confinues It asserts that ordnary

J with these immortal ciizens have the right to

Arid Jne Choose thel kaders

(elebrafions, and to remove from
| oy e ffie thoca wha
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Moving a sentence

One of the best things about a word
processor is its ability to let you
reorganize your text. With Springboard
Publisher, it’s easy to move words,
sentences, or even paragraphs of text.

1. Select the sentence.

a. Place the pointer on any character
in the second sentence.

b. Hold down & and click. This is a
shortcut; you could select the
sentence by dragging the pointer

across it, but this method is faster.

Springboard Publisher has
shortcuts for selecting words and
paragraphs in addition to
sentences; they are explained in
the Details, Details section of this
lesson and on the Desktop
Reference card.

2. Choose the Cut command from the
Edit menu.

You can use the traditional method of
choosing a command from a menu, or
you can use the keyboard shortcut

(& -X).

The program removes the sentence
and the space that follows it and
places it in a special off-screen storage
area called the “clipboard.” Notice
that the remaining text adjusts to fit
the space available.

Move the pointer to the left of the “E”
of Every.

Click to select a new insertion point.

5. Choose the Paste command from the

Edit menu. You can use the
traditional method or the keyboard
shortcut (G -V).

The program inserts the sentence at
the insertion point.

To select a sentence, put
the pointer on any
character in the sentence,
then hold down & and
click.

Page 1

e8] ipel themto the U consider for & moment

i separafion.’y the simple phrase "the
daRiihere e ) consent of the governed”
freworks and speeches  The Declaration confinues It asserts that ordnary
and pienics inthe parky  with these immortal (itzens have the right o~
J words. hoose thekr eaders and
Amid the celebrations, o remove from office
however, it s those who cease o
imnartant far e ta ranracant thair wil | 5,
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The paragraph doesn’t read as well now;
let’s put it back the way it was. Even
though you pasted the selection into a
new location, a copy of it remains on the
clipboard.

1. Choose the Undo command (& -Z)
from the Edit menu. This cancels the
Paste operation, removing the
sentence from your document.

2. Move the I-beam to the beginning of
the first column and click to select the
insertion point.

3. Choose the Paste command (& -V)
from the Edit menu.

The selected sentence appears again.

Formatting text

So far, all of the text you have entered
looks the same. It has the same style of
type, it’s all the same size, and it all starts
at the left margin of the page or column.
But it doesn’t have to—and shouldn’t be
that way. An important element of page
design is formatting, which refers to the
appearance and positioning of text. Text
formatting helps focus a reader’s
attention on the important words on a
page. Springboard Publisher has several
text formatting features. In this lesson
you will change the font, font style, and
font size of the text in the text frame.
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About fonts

A font is a collection of all the characters
on the keyboard which has its own
unique appearance. For example, the font
used for most of the text in this book is
called Palatino.

The font used for this text is called Zapf
Chancery; it's sometimes used for formal
text such as wedding invitations.

Ever since the days of Gutenberg and the
first printing press, people have been
designing fonts to influence their readers’
approach to a page of text. Springboard
Publisher has three fonts from which you
may choose. The preset font, which you
have been using up to now, is called
Serif.

Every font comes in a variety of sizes and
styles. Font size is measured not in
inches but in points; one point is about
1/72 of an inch. Font styles include bold,
italic, underline, and others. Springboard
Publisher has font sizes ranging from 9
point to 72 point as well as eleven font
styles. The preset options are 12 point
size and plain style.



Changing font, font size,
and font style

In Springboard Publisher, you can 5. The Formats command of the Font
change these elements before you start menu allows you to change font, font
entering text, or you can select some style, and font size all at once. We
already-entered text that you want to want the headline for this document
change. In this lesson, we’ll do the latter. to stand out from the rest of the text,

Click anywhere inside the text frame saEhaese the: fellawings

at the top of the page to select it. B Shadow style
2. Move the pointer to the left of the “1” B Bold style (you can choose more

in Independence. than one font style)

Use the scroll bar if you need to move B Sans Serif font

that part of the page into the window. B 18 point size

6. Click the OK button or press Return.

The text now has the attributes you
assigned.

. Drag the pointer straight down so that
all of the text in the frame is selected.

4. Choose the Formats command from
the Font menu (& -D).

Click each of the options, Tent Mode Formats

glei?ncrilck OK or press — Style Font
i Gothic L
[ Bold e,
[ falic :
[ Underline all Serif

[ Underline words Size [“}

[J Underline characters| | 14 Point

[ Ondline 18 Point
& Shadem
[ Superscript _
[J Subscript Character Spacing:

nver s Pigels between characters
o maximum = 9 It
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Changing paragraph indent

Right now the first line of each
paragraph starts at the left margin of the
columns. There is nothing wrong with
that format, but some people prefer to
indent the first line of a paragraph.
Springboard Publisher can do that
automatically with the Formats command
on the Paragraph menu.

1. First, choose the Select Regular Text
command from the Edit menu. This
selects all the regular text in the
document, which is what you want to
change.

2. Choose the Formats command from
the Paragraph menu. The program
displays the Paragraph Formats
dialog box.

. Go to the “First” button in the

Indentation area.
Mouse users: Click in the box.

Keyboard users: Press Tab to get to
the Indentation area, then press the
down arrow key.

. Type .25
5. Click the OK button.

When the program displays your
page again, the first line of every
paragraph is indented a quarter of an
inch.

. Click anywhere on the page to turn

off the Select Regular Text command.

The program recognizes
the first line of the
paragraph as the text that
follows a Return. That's
one reason why it is
important not to press

File Edit Mode Layout Paragraph Font FoniSize FontStyle Graphics

PRACTICE

Return at the end of every
line that you type.

Every year the United

eclare the causes which  walienable rights, but ket

States cobrates e~ impelthem to the U consider for a moment

Fourth of July. There are  separation.’y the simple phrase "the

fireworks and speeches consent of the governed”

and pierics inthe parky ~ The Declarafion It asserts that ordinary

/ confiues with these clizens have the right to
Arnic the thoose thelr leaders

celebrafions. A to remote
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Saving the document

Now is a good time to save the document When you want to save both the original
again. The process is faster the second and updated versions of a document,
time you do it. When you want to save you must choose the Save As command.
only the updated version of an existing The program will display the Save As
document all you have to do is: dialog box, and you can type a new

B Choose the Save command from the name for the updated document.

File menu (¢ -S). The program
replaces the original document with
the updated version without any more
input on your part.
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Details, Details

Selecting units of text

Springboard Publisher offers an easy
way to select any unit of text:

One or more
characters

A word

Drag across the
character(s).

Double-click
anywhere on the
word.

A line Click in the left
margin of the line
(when the pointer is
an arrow).

PressCS -click when
the pointer is on any
of the characters in
the sentence.

Press(3 -click in the
left margin of the
paragraph (when the
pointer is an arrow).
Choose the Select
Regular Text
command from the
Edit menu.

A sentence

A paragraph

All the text in the
regular text area

Undoing your changes

The Undo command, which you learned
about in the Laying out the Page lesson,
works also in text mode. You can use it
to undo cut and paste operations,
formatting changes, and even to erase
what you have typed. Remember that the
Undo command affects your most recent
action, and that you can Redo anything
that you Undo.

Importing documents from other
applications

Springboard Publisher allows you to
bring in word processing documents
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from other applications such as
AppleWorks and Bank Street Writer.
Using this feature, you can transform
your plain old word processing
documents into attractively formatted
and illustrated Springboard Publisher
documents.

Paragraph alignment

The Formats command on the Paragraph
menu offers many more options than just
the first line indentation you used in this
lesson. You can instruct the program to
line up text on the right margin, or center
it, or line it up on both the left and right
margins. You can indent entire
paragraphs from the left or right
margins, or both. And you can adjust the
amount of space that appears between
paragraphs.

Character spacing

In Text mode, you can change the
amount of space that appears between
each character. You can increase the
amount of space, for example, when you
want to draw attention to some text or
fill up space, or you can decrease the
amount of space when you need to fit a
few more characters into a limited area.
Open the Font menu and choose Formats
to access the Character spacing option.

Line spacing

Another Springboard Publisher
formatting feature allows you to change
the amount of space between each line of
text. The preset option is single spacing;
you can change that to double spacing or
to any custom spacing that you desire.
There are three line spacing commands
on the Paragraph menu.



Summary

Now you have added word processing to
your repertoire of Springboard Publisher
skills. All that’s left to learn is how to
create and import graphics, and to print
the document. Here is what you learned
in this lesson:

How to get into text mode: by choosing
the Text command from the Mode menu
or by double-clicking on the part of the
page on which you want to work.

How to enter text: by selecting an
insertion point and typing. When you
need to enter a lot of text, it's a good idea
to turn off the Intuitive Text command
first.

How to correct typing mistakes: by
pressing the Delete key.

How to move around the document: by
using the scroll bar.

How to select text: by dragging the
pointer over it or by using one of the
shortcuts for selecting words, lines,
sentences, paragraphs, or everything in
the regular text area.

How to move selected text: with the Cut
and Paste commands on the Edit menu.

How to change font, font size, and font
style: one at a time, with the commands
on the respective menus; or all at once
with the Font Formats command on the
Font menu.

How to change paragraph alignment:
with the commands on the Paragraph
menu.
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Lesson 4: Graphics

In this lesson you will create your own
artwork inside the graphics frame that
you created in the Page Layout lesson,
and you will import a piece of WORKS
OF ART artwork from the Master
program disk.

Getting into graphics
mode

Graphics mode is the only mode in
which you can create your own artwork.
(You can import artwork in any mode.)
Getting into graphics mode is easy; there
are two ways to do it:

B You can double-click anywhere inside
a graphics frame.

or

B You can select the frame in which you
want to work, then choose the
Graphics command from the Mode
menu.
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For this lesson, select the frame (by
clicking on it), then choose Graphics from
the Mode menu. The program displays
graphics mode, as shown in the
illustration on the opposite page.

What you see is a slightly enlarged view
of the page. There is one big advantage,
and one small disadvantage, to having an
enlarged view:

B The advantage is that the graphics are
proportionally accurate to what you
will get when you print the document.

B The disadvantage is that you cannot
see the full width of the page at one
time. Actually, this is a disadvantage
only when a graphics frame is wider
than the 3-4 inches you can see on the
screen. To enable you to work with
wide graphics frames, the program has
a graphic tool that lets you move the
page under the window, and it has a
horizontal scroll bar. The horizontal
scroll bar works the same as the
vertical scroll bar, which you learned
about in the Word Processing lesson.



Graphics frame: where
you create your artwork

=} Toolbox: contains tools
with which you can draw,
create shapes, erase, enter
text, move the page under
the window, and select.

Lasso
Marquee
E Hand

Text

Paint bucket
Spray can
B8 Paint brush

I Pencil
A Line
Eraser
Shapes

m Line widths: provide a
range of thicknesses for the
drawing tools and for the
borders that go around
shapes. The current width
is checked.

[el Palette: presents 24
patterns that you can use
for painting, drawing lines,
and filling in enclosed
parts of a picture.

Current pattern

Vertical scroll bar:
moves the document up
and down in the window.

3 Horizontal scroll bar:
moves the page from side
to side.

Click to scroll just a
little bit; press to scroll
continuously.

Click anywhere in the
shaded area to scroll a
screen at a time.

PRACTICE
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Creating your own illustrations

Springboard Publisher’s graphic tools
and commands allow you to create a
tremendous variety of artwork. Even if
you don’t consider yourself an artist, you
will be impressed by the quality of the
artwork you can create. And best of all,
using graphics mode is just plain fun!

Experiment!

Now, go ahead and experiment with any

or all of the graphic tools and commands.

No matter what you do, you cannot
damage your document, and everything
that you do you can undo with an eraser
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or the Undo command. When you feel
comfortable with what you are doing,
you can attempt to imitate the artwork
that appears in the sample on page 40, or
you can create your own masterpiece.

Brief descriptions of the tools and
commands appear below to help get you
started. Read the descriptions if you like,
or just experiment on your own. If you
become fascinated with a certain feature,
feel free to turn to the Reference manual
to learn more about it, or to the Desktop
Reference card for a listing of advanced
graphics features.



The toolbox

The toolbox contains icons, or picture For example, to draw with the pencil
symbols, that represent the graphic tools click on the pencil icon, then move back
described on the following pages. To into the frame. The pointer takes on the
select a tool, all you have to do is click its shape of a pencil. When you drag the
icon, then move into the graphics frame pencil, you get a thin line that resembles
and drag the pointer wherever you want what you would get if you drew with a

the tool to take effect.

real pencil on paper.

r=—1 Marquee Selects a rectangular area. Once an area is selected,
e you can:
* Move it (by dragging it)
* Copy it (with the Copy command on the Edit
menu)
* Erase it (by pressing Delete)
* Choose one of these Graphics menu commands:*
* Flip Horizontal
* Flip Vertical
* Rotate
* Scale
* Trace Edges
¢ Invert
* Special Effects
5:} Lasso Selects an area. Unlike the marquee, it tightens up
around the edges of the image that it encloses. Once
an area is selected, you can:
* Move it (by dragging)
* Copy it (with the Copy command on the Edit
menu)
* Erase it (by pressing Delete)
* Choose the Invert or Trace Edges command from
the Graphics menu*
‘:{fﬂ? Hand Allows you to move the page under the window.
This tool can be used instead of the scroll bars.
* The Graphics menu commands are described on page 84. Continued
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Text

Enters text into a graphics frame. By choosing the
Formats command from the Font menu, you can
choose a font, style, and size, as well as vertical
and diagonal text.

Paint bucket

Fills an enclosed area with the current pattern.

Spray can Sprays paint in the current pattern.

Paintbrush Paints in the current pattern.

Pencil Draws a thin line.

Line Draws a straight line.

Eraser Erases whatever you drag it over. Double -
clicking the eraser icon erases everything in the
graphics frame.

Rectangle Draws rectangles.

Rounded-corner
rectangle

Draws rectangles with rounded corners.

Oval

Draws ovals.

Freeform shape

Draws shapes of any form.

NGO 00 L |7~z »

Polygon

Draws many-sided shapes.

Line widths

Determines the width of lines drawn with the
line tool and the shapes. The dotted line width
draws a filled shape with no border.

Palette

The palette has two dozen patterns you can use
to add designs to enclosed areas anywhere
within a frame.
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Erasing your most recent
action

Just as in page mode and text mode, you
can use the Undo command ( & -Z) to
undo your most recent action in graphics
mode. This is a terrific advantage; it
means that you do not need to be
cautious about experimenting with your
illustrations. If you try something and
don’t like it, undo it!

Erasing everything in the
frame

When you want to clear the graphics
frame and start over, all you have to do

is double-click the eraser icon. And if you

do that by mistake, you can choose the
Undo command to bring everything
back.

Saving your work

When you start using the graphic tools, it
can be easy to get absorbed in your
work. But don’t forget to save your
document (using the Save command on
the File menu) every 10 or 15 minutes.
When the unexpected but inevitable
power failure or computer breakdown
occurs, you'll be glad you have made it a
habit to save regularly.
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The Graphics menu

commands
The Graphics menu opens up a whole Feel free to try any or all of the
new world for your artistic expression. commands now.

Zoom Shows a pixel-by-pixel viewpoint of the frame. Helpful
when you need to make detailed changes to your artwork.
To get out of Zoom, choose the command again.

Scale Resizes a marquee selection.

Flip Horizontal Flips a marquee selection left to right.

Flip Vertical Flips a marquee selection top to bottom.

Rotate Rotates a marquee selection 90 degrees each time you choose
the command.

Trace Edges Draws an outline around the outside of a marquee selection.

Invert Changes all the white pixels in a marquee or lasso selection
to black, and all the black pixels to white.

Special Effects Provides options that allow you to skew, distort, rotate, or
change the perspective of a marquee selection. You've got to
see these features to believe them!

Mirrors Instructs the program to draw a mirrored image of whatever
you draw with the paintbrush.

Brushes Allows you to select from 35 different paintbrush shapes.

Edit Pattern Lets you change any of the patterns to suit your needs.

Edit Brush Lets you change any of the paintbrush shapes.
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Importing artwork

No matter how accomplished you 1. Display the part of the page where
become with the graphic tools and you want the artwork to appear. For
commands, you will sometimes want to large pieces of art such as this, it’s
use professionally created artwork. The easiest to import and position the
program allows you to import artwork artwork when you are in page mode.
from the WORKS OF ART series created Choose the Page command from the
especially for Springboard Publisher, Mode menu.

fro(;nff prmgllz eard's g.hp Pt COHECthl’;f, 2. Choose the Import Graphics

ang Irem ol 1ex grapiilcs pregras suc command from the Springboard

a3 aniseRant, menu. Select and open SAMPLE.ART
You can import artwork into an existing from the file listing.

graphics frame, or you can have the
program create a graphics frame for you.
The latter option is particularly helpful
because the program creates a frame that 3. Choose WORKS OF ART from the

The program displays the dialog box

as shown below.

is just the right size to enclose whatever File Format list and Samplel from the
piece of artwork you import. File Name list. Then click the Open

; : button.
For this lesson, we will have the program
create a frame for the Fourth of July The program displays a screen full of
WORKS OF ART artwork that is artwork.

included on your Master program disk.
Here’s how it works:

PN Click the WORKS OF
ART File Format. ..

X /SP.ART/ART.RES =
- I and the Samplel File
: Name...

Sample2

Import Graphics

then click the Open
button.

%)

File Format
Springboard ClipArt
Hi-Res DOS 3.3

Hi-Res ProDO0S ]
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4. Move the pointer to the American flag

artwork and double-click.

The program draws a marquee-like
box around the artwork.

If you do not see the flag, it means
that you picked the wrong filename
from the dialog box. Click the Close
box (Mouse users) or press Esc
(keyboard users), and repeat Step 3.

. Choose the Copy command from the
Edit menu. (& -C)

The program copies the artwork to
the clipboard, then returns to the
PRACTICE document.

. Choose the Paste command (& -V)
from the Edit menu. The program
displays the frame it created for the
artwork.
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7. Move the pointer to the shaded area

of the selection box, then drag the
frame to the bottom right corner of
the text frame so that the bottom and
right boundaries of the graphics
frame match those of the text frame.
Release the mouse button when the
rectangular area is in proper position.

You can put a graphics frame
anywhere on the page, even on top of
another frame. Note that the text
wraps around the graphics frame.

. If you want to see how the flag looks

on your page, switch to graphics
mode by double-clicking the graphics
frame containing the flag. In graphics
mode, you may decide to move the
frame so that it is precisely where you
want it.
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Saving your work

If you haven't saved your document in
the last 15 or 20 minutes, do so now.
Choose the Save command from the File
menu.

Summary

You have just completed your first
document! All that’s left to do is print it
and admire the results.

In this lesson you have learned how to
import artwork from other sources, and
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you have learned by trial and error about
Springboard Publisher’s graphic tools
and commands. If you plan to use the
tools and commands frequently, it would
be helpful to read carefully all the
information in the Graphics chapter of
the Reference manual. The powerful
features of graphics mode are easy to
use, but there are several features you
may not discover unless you read about
them.
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Printing a document

Printing a document is one of the easiest
of all Springboard Publisher operations.
Here’s how it works:

1. Make sure the document that you
want to print is displayed on the
screen. If it isn’t, you need to open it
by using the Open command on the
File menu.

2. Make sure that your printer is turned
on, ready to print, and that your
paper is ready.

3.

Ul

Choose the Print command from the
File menu.

The program displays the Print
Document dialog box. The dialog box
is different for dot matrix and laser
printers.

Double-check the options selected and
change them, if desired.

Click the OK button or press Return.

If something goes wrong while the
document is printing, press Esc to
stop the printer.
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By typing a number in
this box, you can print
more than one copy of
your document.

The From and To
options in the Page Range
area allow you to print
only certain pages from a
multi-page document.

Continuous paper is the
kind with little holes along
the side that fit into your
printer.

A cut sheet is an
individual piece of paper.

Click here when all the
settings are correct.
A

Click here if you want
to cancel the Print
command and return to
your document.

Draft mode prints
faster; Final mode looks
better. (Not available on all
printers.)

You can print at normal
(100%) size, reduce the
printout to as little as 24%,
or enlarge it up to 200%.

B8 Smoothing smooths the
jagged edges that
sometimes appear on

graphics.

Copies: Ii.

Page Range: (= All

Paper Feed: (=) Contintous

Quality: ) Draft

Imagelriter /{
Apple Super 3erial

(O Cut Sheet—2) E
(=) Final

..................

——

|

Copies!

Page Range: (=) All

Mark 0. Public
O From:

@ Smoothing

Laserlriter |1 NT

Paper Feed{é@ Automatic I;:) Manual

Reduce or
Enlarge %
@ Font Substitution H
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When you choose Font
Substitution, the printer
replaces Springboard
Publisher’s fonts with
similar fonts that are
installed in the printer.

Automatic prints all
pages at once, taking paper
as needed from the paper
bin.

Manual allows you to
insert paper one sheet at a
time.

Dot-matrix printer
dialog box

Laser printer dialog box
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Closing a document

Springboard Publisher has two
commands on the File menu to use when
you are done working on a document.
Read about each command, then choose
the one that is best for you on this
PRACTICE document.

® The Quit command lets you quit the
Springboard Publisher application.
Choose this command if you want to
switch applications or turn off your
computer.

If you have made any changes to the
document since the last time you
saved it, the program asks if you want
to save the changes before quitting.

8 The Close command closes the current

document and returns you to the
desktop. This is the command to use
when you want to stop working on
one Springboard Publisher document
and start working on another. Choose
this command if you want to stop
working on the PRACTICE document
and start working on your own
document.

If you have made any changes to the
document since the last time you
saved it, the program asks if you want
to save the changes before closing.
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Lesson 7:
Opening a document

Note: The program should display the The program displays the Open
Springboard Publisher desktop. If it does dialog box. If you do not see your
not, start the program as explained in document listed, then scroll the list as
Everyday startup procedure, page 36. described in the illustration below.
At the beginning of this chapter you used 2. Move the pointer to the document
the New command to start a new name, so that it is highlighted.
Springboard Publisher document. When 3. Double-click the document name, or

you want to resume working on a
document that is closed, you must use
the Open command.

click the Open button, or press
Return. The program displays the
document in page mode.
1. Choose the Open command from the

File menu.

| __—Mouse users: Scroll the
IEX /DATA / list by moving the pointer
to one of the arrows and
D FOO0D ﬁ holding down your mouse
Coms button
[y PRRKING |~ Keyboard users: Scroll the
list by moving the pointer
[ MUSIC
to the top or bottom of the
D MAILING list and holding down the
D PRACTICE / :p (l): do‘vi/vn arrow on your
eyboard.
[ BIRD.CLUB \
e Click New Disk to search

for your document on a
different disk.
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SPRINGBOARD LICENSE AGREEMENT

CAREFULLY READ ALL THE TERMS AND CONDITIONS OF
THIS LICENSE BEFORE USING THIS SOFTWARE. USING
THIS SOFTWARE INDICATES YOUR AGREEMENT TO THE
FOLLOWING TERMS AND CONDITIONS. IF YOU DO NOT
AGREE TO BE BOUND BY SUCH TERMS AND CONDITIONS,
DO NOT USE THIS SOFTWARE. PROMPTLY RETURN THIS
PACKAGE AND OTHER ITEMS THAT ARE A PART OF THIS
PRODUCT TO YOUR PLACE OF PURCHASE AND YOUR
MONEY WILL BE REFUNDED.

1. License Grant. In consideration of payment of the license
fee, which is a part of the price you paid for this product,
Springboard Software, Inc. as Licensor, grants to you, the
Licensee, a nonexclusive license to use and display this
copy of a Springboard software program (the “Software”)
on a single computer at a single location. Springboard
reserves all rights not expressly granted to Licensee
under this License.

2. Software Ownership and Title. As the Licensee, you
own the physical media on which the Software is origi-
nally or subsequently recorded or fixed, but Springboard
retains title and ownership of the Software recorded on
the original disk copy and all subsequent copies of the
Software, regardless of the form or media in or on which
the original and other copies may exist. This License is
not a sale of the original Software or any copy thereof.

3. Copy Restriction. This Software and the accompanying
written materials are copyrighted. Unauthorized copying
of the Software, including Software that has been mod-
ified, merged, or included with other software, or of the
written materials is expressly forbidden. You may be held
legally responsible for any copyright infringement that is
caused or encouraged by your failure to abide by the
terms of this License. Subject to these restrictions, you
may make one copy of the Software solely for backup
purposes. You must reproduce and include the copyright
notice on the backup copy.

4. Restrictions on Use. As the Licensee, you may physically
transfer the Software from one computer to another
provided that the Software is used on only one computer
at a time. You may not electronically transfer the Software
from one computer to another over a network. You may
not distribute copies of the Software or accompanying
written materials to others. You may not modify, adapt,
translate, reverse engineer, decompile, disassemble, or
create derivative works based on the Software. You may
not modify, adapt, translate, or create derivative works
based on the written materials without the prior written
consent of Springboard.

5. Transfer Restrictions. The Software is licensed only to
you, the Licensee, and may not be transferred to anyone
without the prior written consent of Springboard. Any
authorized transferee of the Software shall be bound by
the terms and conditions of this License. In no event may
you transfer, assign, rent, lease, sell, sublicense, or grant
other rights in all or any portion of the Software or any
copy except as expressly provided for in this License. Any
attempt to grant such rights in violation of this License is
void.

6. Termination. This license is effective until terminated.
You may terminate it at any time by destroying the

software together with all copies and all documentation
in any form. This License will terminate automatically
without notice from Springboard if you fail to comply
with any term or condition of this License. Upon termina-
tion you shall destroy the written materials and all
copies of the Software, including modified copies, if any.

7. Limited Warranty, Lifetime Replacement and Dis-
claimer. Springboard warrants to you, the original Li-
censee, that the diskette on which the Software is
recorded is free from defects in material and workman-
ship for as long as you own the diskette. If during that
period you cannot properly load the program, you may
return it together with proof-of-purchase date and $5.00
to cover shipping and handling to Springboard for
replacement, provided that the Software is then cur-
rently being manufactured by Springboard. This Life-
time Replacement is the sole remedy available to you in
the event the diskette contains any defects.

Returns should be sent to:
Springboard Software, Inc.
7808 Creekridge Circle
Minneapolis, MN 55435.

THIS LIMITED WARRANTY IS IN LIEU OF ALL OTHER
EXPRESS WARRANTIES ON THE DISKETTE. THE SOFT-
WARE IS LICENSED ON AN "AS IS” BASIS WITHOUT WAR-
RANTY, AND SPRINGBOARD HEREBY SPECIFICALLY
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES,
INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PUR-
POSE. ANY WARRANTIES WHICH ARE NOT SO EXCLUDED
ARE LIMITED IN DURATION TO THE DURATION OF THE
LIMITED WARRANTY STATED ABOVE. IN NO EVENT SHALL
SPRINGBOARD OR ANY OTHER PARTY WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY
OF THE SOFTWARE BE LIABLE FOR ANY INDIRECT, SPE-
CIAL OR CONSEQUENTIAL DAMAGES, WHETHER RESULT-
ING FROM DEFECTS IN THE DISKETTE, OR ARISING OUT OF
THIS LICENSE, OR RESULTING FROM THE USE, THE IN-
ABILITY TO USE, THE RESULTS OF USE, THE DOCUMENTA-
TION OR PERFORMANCE OF THE SOFTWARE LICENSED
HEREUNDER. IN ANY CASE, SPRINGBOARD'S LIABILITY
FOR ANY CLAIM REGARDING THIS SOFTWARE IS LIMITED
TO THE ORIGINAL PURCHASE PRICE PAID BY YOU, THE
ORIGINAL LICENSEE.

Some states do not allow limitations on how long an
implied warranty lasts, so the above limitation may not
apply to you. Some states do not allow exclusion or limita-
tion of incidental or consequential damages, so the above
exclusion may not apply to you. This warranty gives you
specific rights, and you may also have other rights which
vary from state to state.

8. General. The internal laws of the State of Minnesota
shall govern this License. The invalidity or unenfor-
ceability of any provision of this License shall not affect
the other provisions hereof. This License constitutes the
entire and exclusive agreement, and supersedes any and
all prior agreements and proposals between Spring-
board Software, Inc. and you with regard to the Software
and any other items contained in this package.



SPRINGBOARD SOFTWARE, INC.
7808 Creekridge Circle
Minneapolis, Minnesota 55435
612-944-3912

814.011
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